
Section 2
RT_View

2.1 Overview of the RT_View program

This document introduces the REF TEK RT_View, an appli-
cation designed to allow viewing of REF TEK data. REF TEK/
PASSCAL data files are binary in nature. The data is grouped in 
1024 byte packets. There are a number of different packet 
types. Some packets (i.e. State-of-Health) are mostly plain 
text. Other packets (like data) are mostly binary. 

The RT_View program decodes packets and presents them in 
readable form. For more information on actual internal packet 
structure see the REF TEK Recording Format document. 
RT_View scans the data file and presents a table of contents of 
packet types found. The contents list serves as a jump point to 
decoded packet information.

With a decoded packet displayed, the user has options available 
to move through the file displaying packets of the same type. 
Displaying the packets in its raw binary state is available. Event 
data and packets can be displayed in graphs as well.

Note: At the present time RT_View runs only on the windows 
platform. Windows 95 or above is required.
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Sensor Sensitivity Relationship
2.2 Sensor Sensitivity Relationship
RT_view can display event data in one of three measurements: 

1) counts, 2) volts and 3) G’s (acceleration of gravity). The counts 
format is the raw numerical data from the A/D chips. Volts format 
is the counts data multiplied by the specific volts per count value 
for a data channel. The G’s format is the volts data divided by the 
specific volts per G value for a data channel. The user can change 
the current display format from the “Options” menu item. The user 
can tell the current selection from the Y axis data labels. Values will 
end in “V” for volts and “G” for G’s

When displaying a graph, the status line at the bottom of the dis-
play shows the current mouse pointer position. The values are 
channel number, X axis actual time, X axis relative time (from 
event start) and Y axis value in the current selected display format 
(counts, volts, G’s).

Using RT_View the user can select a portion of an event for exami-
nation. By changing the X axis scales the user can zoom in on a 
particular point of time. Channels can also be selected/deselected 
to include/remove them from the display. The user can then (by 
using the mouse and status line) read values from the graph by 
positioning the cursor. Again the status line values are in the cur-
rent data display format.
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Data Conversion Information
2.3 Data Conversion Information
RT_View uses conversion information stored in the header 

packet of all event files. Conversion information is specific to each 
data channel. 

Conversion information consists of:
• A/D volts per count
• A/D number of bits 
• A/D full scale volts
• Sensor full scale volts 
• Sensor measurement units
• Sensor volts per measurement unit 

If sensor information is not present in the header packet, RT_View 
will use 2.4 Volts/G as a default value.

There are several sources for the conversion information. The A/D 
volts per count is measured at REFTEK and stored in each A/D 
board when built. The A/D number of bits is stored in each A/D 
board when built. The A/D full scale volts is dependent on A/D 
board options and is stored in each A/D board when built.

The sensor values are supplied by the sensor manufacturer. For SM 
units with internal sensors the data is programmed into a serial 
EPROM that the RefTek 130 reads on boot. For the MC-12 and MC-
18 units the user will have to enter the manufacturers data at 
installation time. See the MC-12/18 User manual for information 
entry details.
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To execute the RT_View program
2.4 To execute the RT_View program

To run the RT_View program:

1.  Copy the RT_View.exe program from the CD win32 
directory to the C:\reftek directory and execute.

2.  When first executed an RT_View.ini file is created and 
saved in the same directory as the .exe program.

RT_View.ini file stores settings:
• This file contains options and settings that are stored in the file when the user 

changes options. 
• When the user creates options on the Options menu they can be saved to 

the RT_View.ini file with the SaveOptions menu command located on the 
Options menu.

• The display size and location of the main window is saved in the RT_View.ini 
file.
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Viewing a file
2.5 Viewing a file
The following screens show RT_view and explain what each 

screen is used for by using example steps to open a file.

There are 3 ways to open files:
• Drag and Drop files on an RT_View shortcut or executable.
• Drag and Drop files onto a running RT_View application.
• Use the File and Open menu from the drop-down menu after opening the 

RT_View program.

1.  Start the RT_View application and the following display 
will open.

2.  Use the File > Open drop-down menu to open and view a 
file contents.

Figure 2 - 1 RT_View main application window

Open
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Viewing a file
3.  The file manager window opens to allow browsing for a 
file

4.  Select a file to view.

Figure 2 - 2 Open file manager

5.  Depending on the options selected in the Options menu, 
(shown below) the file selected will open and display 
either:

 •  Graph of the first event data 

 •  Table of Contents

6.  By default data is graphed because these two options 
(shown below on the Options menu) are selected. 

Figure 2 - 3 Options menu

Open

When a data entry in the TOC 

displayed.
When a File is opened (and contains data)
a graph is displayed.

is selected a graph is
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Viewing a file
7.  If there is no event data, the viewer will open showing 
the table of contents of the event file as shown in 
Figure 2 - 4.
-OR-
Contents of a State-Of-Health file (Figure 2 - 5).

Figure 2 - 4 Table of Contents - File view

Figure 2 - 5 SOH file

Name of file

Event Data

Raw data

Event Header Data

Event Trailer Data

Contents
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Viewing a file
Menu Options:

Figure 2 - 6 Menu Options

Open a file

Save an Event to a file

Print a file (Text or graph)

Exit RT_View

Select a font for text in the lists
Select ONLY fixed width fonts in font selection

Goto a packet page number
Search forward for an event start
Search Backward for an event start

Search forward for a break in sequence numbers

Locate SOH text

Graph data in different units

Each trace separately auto-scaled in the Y-axis

Data Filtering Options

of measurement

Set default value when not present in the data

Arithmetic mean of the entire event is subtracted
from each data point

Graphing data options

Save Options to the ini file

Force use of nominal Bit weight
Force use of nominal G values

Set Auto Scroll Options

Version
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Viewing Event Header Data
2.6 Viewing Event Header Data

To view Event Header Data:

1.  Double-click the Event Header Data entry in the table of 
contents. This allows viewing of the header part of the 
file.

2.  The Header display opens a view of the header page.

Figure 2 - 7 Header
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Viewing Event Header Data
3.  Clicking the tabs located at the bottom of the display 
allow a different view of the file header.

4.  Event Header - Raw

Note: The file classifications at the bottom of the display reveal the 
supported viewing formats of the data page.

Header
Raw

Contents
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Event Data Header/Trailer description
2.7 Event Data Header/Trailer description

To view an Event Header or trailer:

1.  Double-click the Event Header Data or Event Trailer 
Data entry in the table of contents. This allows viewing 
of the header part of the file.

Figure 2 - 8 Table of contents

2.  The Header display opens a view of the header page.

Figure 2 - 9 Top of header page

Unit ID

Station name

Stream number

Event number

Data format
Sample rate

Stream name

True bit weight

Nominal bit weight

Trigger time
Command,continuous

Time Source
Time Quality

First sample time
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Event Data Header/Trailer description
3.  Use the scroll-bar to view the bottom page of the header.

Figure 2 - 10 End of header page

A/D Resolution

Full Scale Analog

Sensor Channel Code

Sensor Full Scale
Analog Voltage

Sensor volts per
measurement unit
Sensor units

Latitude,Longitude
Altitude

Channel Gain

Voltage
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Viewing Event Data
2.8 Viewing Event Data

To view Event Data:

1.  Double-click the Event Data entry in the table of con-
tents. This allows viewing of the data.

Figure 2 - 11 Event Data contents
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Viewing Event Data
2.  Clicking the Graph button opens a time series graph of 
the Event data.

Figure 2 - 12 RT_View of the data

The following close-up views of the displays show how to use 
areas of the display.

Figure 2 - 13 Section A - Upper-Left display

Figure 2 - 14 Pull-Down menu options

A B

C

D

A File Name

DAS Unit ID

Event number and Stream
First sample time in the
Event Header
Select channels to display
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Viewing Event Data
Figure 2 - 15 Section B - Upper-Right display

Figure 2 - 16 Section C - Lower-Left display

Figure 2 - 17 Section D - Lower-Right display

B

Mark all samples
Mark the first sample in a packet

Event sample rate

C

Contents of a data file

Graph of a data fileSupported
Viewing
Formats

Raw data view

Mouse clicks
zoom to an
area of data

Mouse clicks
measure and
display data

Data view of a file

Number of
seconds between
each vertical
division

Relative time from 1st sample in event for start of
Time in event for start of display window

Displays mouse position with channel number
time, with X and Y coordinates

display window

D

Turns on auto scroll of data
according to scroll delay options
set in the options menu

Time in event for end of display window

Relative time from 1st sample in event for end of
display window
2-21



Viewing Event Data
3.  Click the Data button opens a view of sample data.

Figure 2 - 18 Data view

4.  Clicking the Raw button open a raw data view of the 
Header Page.

5.  Select the Contents button to return to the table of con-
tents to view another part of the file.
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Options menu
2.9 Options menu
The RT_view program has several viewing options that can 

be applied as each screen of data is viewed. Placing the mouse 
cursor anywhere in the graphic area displays on the status line the 
cursor position in the graph. The status line displays x and y val-
ues.

1.  Select the drop-down Option menu to allow graphing of 
the event data with different units (Counts, Volts, or 
G’s), set G_Entry options, add viewing options, and to 
save present options as default.

Figure 2 - 19 Counts option

Note: Select the Graph on TOC Select option to open any data view 
with the graphical view option as default.

Displays mouse position with channel number
time, with X and Y coordinates

Viewing options

Save options as default
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Options menu
2.  Select the counts option to view the data in raw digital 
counts.

Figure 2 - 20 Counts display example

Counts

Range in Counts

Mean in Counts

Note: Counts updated from cursor position are displayed on the bottom of the 
window. Range, Mean, and status line Y values are in counts.
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Options menu
2.9.1    Using the Volts option

1.  Select the Volts option to view the data with volts as the 
units of measurement.

Figure 2 - 21 Volts option

2.  The volts per count conversion is automatically read from 
the Event Header packet (a true Bit Weight field).

Figure 2 - 22 Volts display example

Volts

Volts display

Range in Volts

Mean in Volts

Note: Volts updated from cursor position are displayed on the bottom of the 
window. Range, Mean, and status line Y values are in volts.
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Options menu
2.9.2    Using the G’s option

1.  Select the G’s option to view the data with G’s as the 
units of measurement.

Figure 2 - 23 G’s option

2.  The window refreshes to view the data with G’s as the 
units of measurement.

Figure 2 - 24 G’s display example

G’s

G’s

Note: G’s updated from cursor position are displayed on the bottom of the 
window. Range, Mean, and status line Y values are in G’s.
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Options menu
2.9.3    Using the G’s entry option

Nominal G entry is used to set default values for when they are not 
present in the event data. If the event data contains these values 
then they take priority over any of these user entered values.
1.  To change the per channel volts per G conversion value 

use the G’s entry option on the Option menu.

Figure 2 - 25 G_Entry option

2.  Under the Options menu, select the Gs_Entry option.

Figure 2 - 26 G_Entry display

G_Entry

Defaults
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Options menu
If the defaults icon is disabled (grayed out) the RT_View.ini file 
must be updated with any windows editor to enable editing.

1.  Open the RT_View.ini file.

Figure 2 - 27 Edit RT_View.ini file

Example RT_View.in file

Figure 2 - 28 RT_View.ini file

Change this value
to a 1 to allow 
editing of default 
values.
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Options menu
2.9.4    Using Independent-Y-Scaling (Scale By Trace)

Scale-by-trace (in the option menu) is defined as each trace sepa-
rately auto-scaled in the Y-axis (amplitude). 

If Scale-By-Trace is on the display reads “Independent Y Scaling”.

If Scale-By-Trace is off the display reads “Common Y Scaling”.

With these enabled or disabled the window is updated as shown 
below with the current option selected.
1.  Select the Scale By Trace option on the Option menu to 

enable this option.

Figure 2 - 29 Scale By Trace option

2.  The screen redraws with Scale By Trace enabled.

Figure 2 - 30 Counts display with Scale By Trace enabled

Scale By Trace

Mean Removal disabled Scale By Trace enabled
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Options menu
2.9.5    Using the Mean Removal option

Mean removal is when an arithmetic mean of the entire event is 
subtracted from each data point (or sample).

With these enabled or disabled the window can be updated as 
shown below with Common-Y-scaling and Mean Removal Off.
1.  Select the Mean Removal option on the Option menu to 

enable this option.

Figure 2 - 31 Mean Removal option

2.  The screen redraws with Mean Removal and Scale By 
Trace enabled

Figure 2 - 32 Counts display example with Mean Removal enabled.

Mean Removal

Mean Removal enabled Scale By Trace enabled
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Options menu
2.9.6    Using the Data Filtering option

Data filtering is used to allow the user to view the event data as 
the triggering software in the DAS does.

1.  Select the 2Hz HiPass Filter and 12Hz LoPass Filter 
option on the Option menu to enable this option.

Figure 2 - 33 Mean Removal option

2.  The screen redraws with 2Hz HiPass Filter and 2Hz 
LoPass Filter enabled

Figure 2 - 34 Display example with filtering options enabled.

2Hz High-Pass Filter
12Hz Low-Pass Filter

0.1Hz High-Pass Filter

2Hz High-Pass enabled
12Hz Low-Pass enabled
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Options menu
This detail view shows the 2Hz HiPass Filter and 12Hz LoPass Filter 
indicators as enabled.

Figure 2 - 35 Display example with filtering indicators enabled.

2Hz High-Pass enabled

12Hz Low-Pass enabled
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Zooming
2.10 Zooming
1.  It is also possible to zoom in to an area of data by using 

the left mouse button to select a window area in one data 
window as shown below, and dragging across to select a 
new viewing window.

Figure 2 - 36 Dragging a new selection area

2.  A new window is displayed based on the new selection 
area. All channels are zoomed the same amount.

Figure 2 - 37 Zoomed data view

3.  To cancel a zoom right click in the graph. Each right click 
cancels one level of zoom and restores the previous dis-
play.

New selection area

Note: It is possible to undo up to 99 zoom in operations.

Note: The scroll bars may also be used for a zoom operation but changes are not 
remembered for undo operations.
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Measure
2.11 Measure

It is also possible to measure amplitude or time

1.  Select the Measure option check box.

Figure 2 - 38 Measure options

2.  Select an area to measure using the mouse.
3.  Note the measurement in the area shown below in units 

of time and amplitude.

Figure 2 - 39 Measuring
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Viewing a State-of-Health file
2.12 Viewing a State-of-Health file
To view a State-of-Health file:

• Drag and Drop files on an RT_View shortcut or executable.
• Drag and Drop files onto a running RT_View application.
• Use the File and Open menu from the drop-down menu after opening the 

RT_View program.

1.  Close any open file first before opening a State-of-Health 
file by selecting File and Close.

2.  Open a State-of-health file by selecting the file and using 
the Open button.

Figure 2 - 40 Select a State-of-health file

3.  Double-clicking a State of Health Info entry in the table 
of contents allows viewing of the state-of-health packets 
in the file.

Figure 2 - 41 State of Health contents.

Note: The file classifications at the bottom of the display reveal the supported 
viewing formats of the file.
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Viewing a State-of-Health file
4.  Clicking Raw allows different views of the data.

Figure 2 - 42 Event file contents

5.  Clicking SOH tab opens an entry listing view of the SOH 
packet.

Figure 2 - 43 SOH view

SOH

Raw

Raw

SOH
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 Appendix B
RT_View Release Notes

B.1 Version 1.4.3 (August 7, 2006)
This section of this manual lists and describes the func-

tional modifications made to the Ref Tek RT_View software
version 1.4.2 to create version 1.4.3, as follows:

1. Corrected spelling of scaling on graph page.
2. Modified Print Graph horizontal center grid line to a dash at

each vertical seconds grid line.
3. Added Station Name to on screen graph and printed

graph.
4. Added detection of new Sensor Test flag and display on

Event Header, Trailer and Data pages.
5. Added Display Sensor Test message on Graph page.

WARNING: Please review all release notes between the software 
version you are running and the version you wish to install.
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Version 1.4.3 (August 7, 2006)
 1 Corrected spelling of scaling.
Corrected spelling of scaling on the graph page.

 2 Modified Print Graph horizontal center grid.
Modified Print Graph horizontal center grid line to a dash at each verti-
cal seconds grid line

 3 Added Station Name to screen display.
Added Station Name to screen graph and printed graph.

 4 Added detection of new Sensor Test flag.
Add detection of new Sensor Test flag and display on Event Header, 
Trailer and Data pages.

 5 Added Display Sensor Test message.
Added Display Sensor Test message on graph page.
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Version 1.4.2 (June 18, 2007)
B.2 Version 1.4.2 (June 18, 2007)
This section of this manual lists and describes the functional

modifications made to the Ref Tek RT_View software version
1.4.1 to create version 1.4.2, as follows:

1. Corrected marked samples color.
2. Corrected ALT+left_click on graph failure.
3. Corrected saved graph image 4Kx2K.
4. Corrected overlap of auto scroll check box.
5. Corrected vertical scaling.
6. Modified Graph Tab (removed).
7. Modified saved image size.
8. Modified saved graph image.
9. Modififed Options menu item GraphEventData.

10. Modified SPS, Event # and add Stream #.
11. Modified filter tags to say Off.
12. Modified to allow any mouse click in graph.
13. Added listing packets in Table of Contents.
14. Added support for data format codes 33, C1 and C3. 
15. Added forcing of the file last packet displayed.
16. Added more graphing of events.
17. Added time width of current graph.
18. Added Options menu item Graph on File Open.
19. Added analog filter code.
20. Added line for overscale count if it is non-zero.
21. Added gain and full scale voltage support.
22. Added scroll delay values to the Options.
23. Added Auto Scroll check box to allow scanning.

WARNING: Please review all release notes between the software 
version you are running and the version you wish to install.
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Version 1.4.2 (June 18, 2007)
 1 Corrected marked samples color.
Corrected marked samples color changing from black to red on 
refresh.

 2 Corrected ALT+left_click on graph failure.
Corrected ALT+left_click on graph falure due to changes to display 
graph on program open.

 3 Corrected saved graph image 4Kx2K.
Corrected saved graph image 4Kx2K caused “out of memory”when 
multiple programs opened.

 4 Corrected overlap of auto scroll check box.
Corrected overlap of auto scroll check box and enabled filter flags.

 5 Corrected vertical scaling.
Corrected vertical scalling during auto scroll.

 6 Modified Graph Tab (removed).
Modified Graph Tab (removed) when Header or Trailer Tabs dis-
played (part of ALT+left_click problem).

 7 Modified saved image size.
Modified saved image size to current system screen resolution.

 8 Modified saved graph image.
Modified saved graph image from 2000 x 2000 to 4000 x 2000.

 9 Modififed Options menu item GraphEventData.
Modififed Options menu item GraphEventData to Graph on TOC 
Select.

 10 Modified SPS, Event # and add Stream #.
Modified SPS, Event # and add Stream # to printer plot.

 11 Modified filter tags to say Off.
Modified filter tags to say Off instead of blank on printer plot.

 12 Modified to allow any mouse click in graph.
Modified to allow any mouse click in graph window to disable auto 
scroll.

 13 Added listing packets in Table of Contents.
Added listing packets in Table of Contents with packet overscale flag 
set.
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Version 1.4.2 (June 18, 2007)
 14 Added support for data format codes 33, C1 and C3.
Added support data format codes 3, C1 and C3 for samples marked 
overscale. 

 15 Added forcing of the file last packet displayed.
Added forcing of the file last packet displayed in the table of contents 
along with a ‘end of file’ message.

 16 Added more graphing of events.
Added graphing of events without event headers and/or trailers.

 17 Added time width of current graph.
Added time width of current graph to bottom of graph.

 18 Added Options menu item Graph on File Open.
Added Options menu item Graph on File Open to skip display of the 
contents.

 19 Added analog filter code.
Added analog filter code to channel gain field.

 20 Added line for overscale count if it is non-zero.
Added line for overscale count if it is non-zero.

 21 Added gain and full scale voltage support.
Added gain and full scale voltage support for RT601 A/D boards (QH 
DAS firmware).

 22 Added scroll delay values to the Options.
Added 3 scroll delay values to the Options menu.

 23 Added Auto Scroll check box to allow scanning.

Added Auto Scroll check box to allow scanning through the entire
event.
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Version 1.4.1 (August 7, 2006)
B.3 Version 1.4.1 (August 7, 2006)
This section of this manual lists and describes the functional

modifications made to the Ref Tek RT_View software version
1.4.0 to create version 1.4.1, as follows:

1. Corrected bug when graphing filtered data that did not
scale traces correctly.

2. Modified click on X scroll bar behavor to small change of 1
sec and large change of current zoom width.

3. Added text to printer output if filters are on.
4. Added version display in top left of window.

WARNING: Please review all release notes between the software 
version you are running and the version you wish to install.
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Version 1.4.0 (September 23, 2005)
B.4 Version 1.4.0 (September 23, 2005)
This section of this manual lists and describes the functional

modifications made to the Ref Tek RT_View software version
1.3.0 to create version 1.4.0, as follows:

New Features since 1.3.0

1. Add data filtering of 12Hz low pass, 0.1Hz High pass and
2Hz High pass.

2. Add decode of Trigger Out Delay in Event Headers and Trail-
ers.

3. Added a INI file entry to enable/disable editing of nominal
Volts per G values.

4. Added support for 18 channels.

Changes for version 1.4.0

1. Corrected zoom glitch.
2. Corrected contents list.
3. Corrected Next and Back Button.
4. Corrected not reading header.
5. Corrected existing print bug.
6. Corrected long integer overflow calculating time.
7. Corrected memory overwrite.
8. Modified text windows.
9. Modified header 2 and trailer 2.

10. Modified file open.
11. Modified Menu subitem.
12. Modified the Gs Entry screen.
13. Modified AllowGsEntry.
14. Modified Event header and trailer.
15. Modified data page contents.
16. Modified stream number.
17. Added SOH text search.
18. Added total recorder channels.
19. Added decode calibration schedule.
20. Added flag data decompression.
21. Added display of stream number.
22. Added marker for first sample of data packet.
23. Added save filter selection to ini file.

WARNING: Please review all release notes between the software 
version you are running and the version you wish to install.
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Version 1.4.0 (September 23, 2005)
24. Added filtering options.
25. Added decode of Trigger Out Delay.
26. Added the actual used Volts per G values.
27. Added an INI file entry for AllowGsEntry.
28. Added Decode calibration schedule.
29. Added detection of data compression control flag errors.
30. Added detection of number of decompressed values error.
31. Added ability to flag above errors in contents and on data

tab.
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Version 1.4.0 (September 23, 2005)
Version 1.4.0

 1 Corrected zoom glitch
Corrected glitch when zoomed in middle of event at beginning of 
window.  Start filter 1000 samples before displayed data.

 2 Corrected contents list
Corrected contents list jump to page for long lists, bug introduced 
with 18 chan support (1.3.0.10).

 3 Corrected Next and Back Button
Corrected Next and Back Button on graphs for multiple events, bug 
introduced with 18 chan support (1.3.0.10).

 4 Corrected not reading header 1
Corrected not reading header 1 for bit-weights in 18 channel file.

 5 Corrected print bug
Corrected existing print bug that overwrote the top of page.

 6 Corrected long integer overflow calculating time
Corrected long integer overflow calculating time.  When using the 
mouse to point at data, the reported time would suddenly change 
drastically.

 7 Corrected memory overwrite
Corrected memory overwrite in getgamples for steim 2 when data 
packet number of samples equals zero and when data packet number 
of samples equals zero.

 8 Modified text windows
Modified text windows to allow vert and horz scroll bars.

 9 Modified header 2 and trailer 2
Modified header 2 and trailer 2 in contents, raw, header and trailer 
tabs.

 10 Modified file open
Modified file open to be ReadOnly and ShareDenyNone.

 11 Modified Menu subitem
Modified Menu subitem from G_Entry to “Nominal G Entry”.

 12 Modified the Gs Entry screen
Modified the Gs Entry screen title text to read “Nominal Volts Per G 
Values”.
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Version 1.4.0 (September 23, 2005)
 13 Modified AllowGsEntry
Modified AllowGsEntry to disable the Option submenu items Use-
NominalBitWeight and UseNominalVperG and also to disable the OK 
and Defaults buttons in the Nominal G Entry screen.

 14 Modified Event header and trailer
Modified Event header and trailer; time source, time quality decod-
ing. Added to Event header and trailer; total recorder channels.

 15 Modified data page contents
Modified data pages in contents for a second event in the file with 
the same event number. Added display of data pages in contents for 
a second event in the file with the same event number.

 16 Modified stream number
Modified stream number to display in top panel when graphing.

 17 Added SOH text search
Case insensitive

 18 Added total recorder channels
Added total recorder channels to Event header and trailer decoding.

 19 Added decode calibration schedule
Added decode calibration schedule in Cal packets produced by 130 
firmware release 2.7.0.

 20 Added flag data decompression
Added flag data decompression and number of decompressed values 
errors in contents and on data tab.

 21 Added display of stream number
Added display of stream number in top panel when graphing.

 22 Added display of stream number

 23 Added marker for first sample of data packet

 24 Added save filter selection to ini file

 25 Added filtering options
Added filtering, 12Hz Lopass, 0.1Hz Hipass and 2Hz Hipass.

 26 Added decode of Trigger Out Delay
Added decode of Trigger Out Delay in Event Headers and Trailers.
B-164  RT_View Users Guide RTV-OP-005-B



Version 1.4.0 (September 23, 2005)
 27 Added the actual used Volts per G
Added the actual used Volts per G values to the Nominal G Entry 
Screen.

 28 Added an INI file entry for AllowGsEntry
Added an INI file entry for AllowGsEntry.  Default entry to off.

 29 Added Decode calibration schedule
Added Decode calibration schedule in Cal packets produced by 130 
firmware release 2.7.0.

 30 Added detection of data compression control flag errors.
Added ability to flag above errors in contents and on data tab.

 31 Added detection of number of decompressed values error.
Added ability to flag above errors in contents and on data tab.
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B.5 Version 1.3.0 (September 23, 2005)
This section of this manual lists and describes the functional

modifications made to the Ref Tek RT_View software version
1.2.0 to create version 1.3.0, as follows:

New Features since 1.2.0

1. Added support for filter description packet.
2. Added support for Steim 2 decompression.
3. Added G’s entry for channels 7-16.
4. Added Time align the graph x axis.
5. Added time to each line of samples in Data tab.
6. Added use of ALT key with mouse to switch to the data tab

for that time.
7. Added MarkSamples check box to draw circles around sam-

ple points.
8. Added time in hh:mm:ss format to status bar for mouse

position in graph.
9. Added channel display check boxes to top panel.

10. Added Menu Options for force use of nominal bit weight and
nominal volts per G

11. Added zoom button, measure button and measure text to
graph page.

12. Added Left and right mouse click either hi-light/zoom or hi-
light/measure time.

13. Added support for 72A scsi disk data (multiple units and
events interleaved.)

14. Modified to speed up graphing
15. Modified table of contents to remember the last selected

item.
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Changes for version 1.3.0

1. Corrected printing problem.
2. Corrected run time error.
3. Corrected decoding of Data Stream packet.
4. Corrected runtime error.
5. Corrected bug in 32-bit data.
6. Corrected bug in steim 2.
7. Corrected decode of steim.
8. Corrected mean value computation.
9. Corrected printing lockup.

10. Corrected scroll bar arrows.
11. Corrected mouse click.
12. Corrected rounding error.
13. Corrected plotting error.
14. Corrected measuring Y value.
15. Corrected graphing data.
16. Corrected mouse move display.
17. Corrected event without data.
18. Corrected Date conversion.
19. Corrected packet graphing.
20. Corrected data page error.
21. Corrected graphing bad date error.
22. Corrected end event errors.
23. Corrected channel graphing.
24. Corrected search functions.
25. Corrected contents tab.
26. Corrected graph interleave.
27. Modified decode data destination.
28. Modified filter packet decode.
29. Modified sample rate.
30. Modified multiple program copies.
31. Modified filter packet format.
32. Modified event channels.
33. Modified to work with rtcnvrt.
34. Modified G’s.
35. Modified X graphing grid.
36. Modified Mark Sample.
37. Modified Packet time.
38. Modified default to 3 channel.

WARNING: Please review all release notes between the software 
version you are running and the version you wish to install.
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39. Modified channel number.
40. Modified channel check boxes.
41. Modified hi-light region limit.
42. Modified left and right mouse click.
43. Modified graphing speed.
44. Modified disk access.
45. Modified zoom.
46. Modified windows short date.
47. Modified draw.
48. Modified screen graph.
49. Modified printed plot.
50. Modified TOC.
51. Added data packet type.
52. Added data tab message.
53. Added graph color change.
54. Added SaveEvent function.
55. Added FD decode.
56. Added Steim 2 decompression.
57. Added G’s entry for Ch 7-16.
58. Added PI decode.
59. Added event header info.
60. Added time to Data tab.
61. Added use of ALT key.
62. Added MarkSamples.
63. Added time format.
64. Added channel display boxes.
65. Added status bar.
66. Added bit weight menu options.
67. Added zoom button.
68. Added channel check boxes.
69. Added 0.1 graphing.
70. Added disable of NEXT and BACK.
71. Added Save screen.
72. Added DAS checking of S/N.
73. Added drag and drop.
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 1 Corrected printing of filter description
Corrected printing of filter description packet.

 2 Corrected run time error
Corrected run time error when a packet is more than 24 days from 
event start. Time is forced to a max of 24 days from event start.

 3 Corrected decoding of Data Stream packet
Corrected decoding of Data Stream packet with two streams having 
the same trigger type.

 4 Corrected runtime error
Corrected runtime error on close due to small array size filter packet 
coefficients.

 5 Corrected bug in 32 bit data
Corrected bug in 32 bit data introduced in 1.2.0.20.

 6 Corrected bug in steim 2
Corrected bug in steim 2, 15 bit value decode.

 7 Corrected decode
Corrected decode of steim 2. Corrected decode of steim 1 bug intro-
duced in 1.2.0.20.

 8 Corrected mean value computation
Corrected mean value computation to be the displayed data instead 
of entire event.

 9 Corrected printing lockup
Corrected lockup in printing the graph from beta 15.

 10 Corrected scroll bar arrows
Corrected click of scroll bar arrows to move in step size of 1 sample.

 11 Corrected mouse click
Corrected ALT mouse click not display correct channel or time. Cor-
rected mouse to status bar display when channels are not displayed.

 12 Corrected rounding error
Corrected rounding in calc of date time from mouse position result in 
1mS error.

 13 Corrected plotting error
Corrected plotting of very first sample, 1 sample period late.
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 14 Corrected measuring Y value
Corrected measure Y value jump when mouse moves to another 
channel area.

 15 Corrected graphing data
Corrected Graph Data (when units of G’s selected) to use event 
header volts per G otherwise use value in G’s entry table.

 16 Corrected mouse move display
Corrected mouse move display of x value to use a saved sps from 
graphing event.

 17 Corrected event without data
Corrected to handle event with no data.

 18 Corrected Date conversion
Corrected Date conversion to use windows DateSeperator character.

 19 Corrected packet graphing
Corrected problem in graphing when back to back packets are the 
same channel.

 20 Corrected data page error
Corrected going to last data page if no event trailer.

 21 Corrected graphing bad date error
Corrected “Bad Date” error on graph.  Reload event header after 
scanningfor data min max because another event header for a new 
eventcould have been read.

 22 Corrected end event errors
Corrected more places checking for end event with DAS and event 
numbers.

 23 Corrected channel graphing
Corrected graph if channel data first samples are not time aligned.

 24 Corrected search functions
Corrected search functions to exit proper when starting 1 page from 
end(forward search) or beginning (back search).

 25 Corrected contents tab
Corrected contents tab to display every event header and trailer.
Other like pages that follow are suppressed in the contents as 
before.
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 26 Corrected graph interleave
Corrected graph if more than one event in file and the events are 
interleaved.

 27 Modified decode data destination
Modified decode data destination in stream info and aux info to be 
position dependentinstead of value dependent.

 28 Modified filter packet decode
Modified filter packet decode per change in recording format.

 29 Modified sample rate
Modified to handle 0.1 sample per second rate.

 30 Modified multiple program copies
Modified spawn multiple copies of program when more than one file 
drag and drop on program.

 31 Modified filter packet format
Modified format of filter packet scaller display.

 32 Modified event channels
Modified the channels of an event to be written to ascii files.

 33 Modified to work with rtcnvrt
Modified filenames and content to match that of REF TEK rtcnvrt 
program.

 34 Modified G’s
Modified default G’s to 2.4.

 35 Modified X graphing grid
Modified graph X grid to be time aligned instead of relative to first 
sample. Modified graph X grid to show short ticks at 0.1 second 
intervals and top to bottom line on the second when grid is 1 sec/div.

 36 Modified Mark Sample
Modified and moved “Mark Samples” option from menu to a Check 
box on the Graph tab.

 37 Modified Packet time
Modified the Packet time to locate where to place the first sample of 
packeton the graph.

 38 Modified default to 3 channel
Modified default to 3 channel check boxs visible at file open.
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 39 Modified channel number
Modified channel number text limit if more than 6 channels on 
screen.

 40 Modified channel check boxes
Modified visible only channel check boxes for active channels in 
event.

 41 Modified hi-light region limit
Modified the limit of the hi-light region to present channel when 
measure button checked.

 42 Modified left and right mouse click
Modified left and right mouse click to be either hi-light/zoom or hi-
light/measure time.

 43 Modified graphing speed
Modified and speed up graphing by reducing the line drawing calls 
made.

 44 Modified disk access
Modified and reduced disk access by storing select information for 
each packet in an array.

 45 Modified zoom
Modified zoom to not allow zoom scroll bar to go to zero.

 46 Modified windows short date
Modified windows short date format to properly position the year ( 
m/d/y  y/m/d ) in internal date conversion (started in v1.2.0.7 
beta).

 47 Modified draw
Modified draw to save the bitmap at same time as screen to allow 
window to go to background and finish the plot.

 48 Modified screen graph
Modified screen graph limitation of 6 channels to now be 16.

 49 Modified printed plot
Modified printed plot if first channel is not 1.

 50 Modified TOC
Modified the table of contents remember the last selected item for
when the user goes back to the contents.
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 51 Added data packet type
Added data packet type to contents header and trailer message.

 52 Added data tab message
Added message in data tab if decompressed last page sample does 
not match the stored last value.

 53 Added graph color change
Added change of graph plot color from red to black for packet that 
the decompressed last sample does not match the stored last value.

 54 Added SaveEvent function
Added the Enable of the SaveEvent menu function.

 55 Added FD decode
Added decode of FD (filter description) packet type.

 56 Added Steim 2 decompression
Added Steim 2 decompression for C2 data packet.

 57 Added G’s entry for ch 7-16
Added G’s entry for channels 7-16.

 58 Added PI decode
Added decode of Parameter Implement Time field in Aux, Cal, Data 
Stream, Op Modeand Station Channel packets.

 59 Added event header info
Added event header channel gain codes F to J.

 60 Added time to Data tab
Added time to each line of samples in Data tab.

 61 Added use of ALT key
Added use of ALT key with mouse left click to switch to the data tab 
and packet containing that time point.

 62 Added MarkSamples
Added MarkSamples menu item to draw circles around sample 
points.

 63 Added time format
Added time in hh:mm:ss format to status bar for mouse position in 
graph.
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 64 Added channel display boxes
Added channel display check boxes to top panel.

 65 Added status bar
Added status bar hints for menu items.

 66 Added bit weight menu options
Added Menu Options for force use of nominal bit weight and nominal 
volts per G.

 67 Added zoom button
Added zoom button, measure button and measure text to graph 
page.

 68 Added channel check boxes
Added channel check boxes to a panel in the graph tab sheet.

 69 Added 0.1 graphing
Added 0.1 sec/div capability to graphing.

 70 Added disable of NEXT and BACK
Added disable of NEXT and BACK button during graphing.

 71 Added Save screen
Added Save screen to bitmap for fast repaint when switching 
between windows programs.

 72 Added DAS checking of S/N
Added checking of the DAS s/n and event num for Back and Next 
buttons.

 73 Added drag and drop
Added function to allow file drag and drop without doing a file/close 
first.
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B.6 Version 1.2.0 (June 8, 2004)
This section of this manual lists and describes the functional

modifications made to the Ref Tek RT_View software version
1.1.0 to create version 1.2.0, as follows:

1. Corrected an off by one problem.
2. Corrected divide by zero.
3. Corrected display problem.
4. Corrected close file windows handle.
5. Corrected continuos trigger start time.
6. Corrected event header and trailer station.
7. Corrected field sizes in event header and trailer.
8. Modified hard coded field length.
9. Modified all hard coded field position/length values.

10. Added event header and trailer sensor units fields.
11. Added changed size of sensor VPU field.
12. Added decoding of filter list codes.
13. Added event header and trailer fields.
14. Added chan and sensor fields to event header and trailer.
15. Added time source, time quality and station comment.
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Please review all release notes between the software version you are 
running and the version you wish to install.

 1 Corrected an off by one problem.
Corrected an off by one problem in Menu > Locate > gotopage.

 2 Corrected divide by zero.
Corrected divide by zero when file had only and event header, no 
data and user clicked on “graph” tab.

 3 Corrected display problem.
Corrected display problem with event header and trailer new fields.

 4 Corrected close file windows handle type.
Corrected close file windows handle type from menu File Exit.

 5 Corrected continuos trigger start time.
Corrected continuos trigger start time field length.

 6 Corrected event header and trailer.
Corrected event header and trailer station comment field length.

 7 Corrected field sizes in event header and trailer.
Corrected field sizes in event header and trailer per Recording for-
mat doc dated May 13, 2004.

 8 Modified hard coded field length.
Modified hard coded field length for sensor volt per unit in event 
header and trailer packet decode.

 9 Modified all hard coded field position/length values.
Modified all hard coded field position/length values (in event header 
and trailer decode) with entries already defined in include file.

 10 Added event header and trailer sensor units fields.
Added event header and trailer sensor units fields.

 11 Added changed size of sensor VPU field.
Added changed size of sensor VPU field in header and trailer.

 12 Added decoding of filter list codes.
Added decoding of filter list codes.

 13 Added event header and trailer fields.
Added event header and trailer new fields.
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 14 Added chan and sensor fields to event header and trailer.
Added chan gain, chan a/d resolution, chan FSA, chan code, sensor 
FSA and sensor VPU to event header and trailer.

 15 Added time source, time quality and station comment.
Added time source, time quality and station comment to event 
header and trailer.
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B.7 Version 1.1.0 (February 26, 2004)

This section of this manual lists and describes the functional 
modifications made to the Ref Tek RT_View software version 1.0 to 
create version 1.1.0, as follows:

1. Corrected drag and drop of a file to shortcut.
2. Corrected print graph x axis.
3. Corrected scroll bars to default on file open.
4. Corrected close file handle.
5. Corrected event station comment.
6. Corrected continuous trigger start time.
7. Corrected display problem.
8. Corrected divide by zero with no data.
9. Removed range from status line display.

10. Modified opening files to be Read-Only.
11. Modified hard coded field lengths.
12. Modified field sizes (event header and trailer).
13. Added vertical range to Status line text.
14. Added drag and drop of a file to running program. 
15. Added units label to y scale values.
16. Added ScaleByTrace option.
17. Added graph Y center line value.
18. Added mean removal option.
19. Added graph zoom/unzoom.
20. Added print graph Y center line value.
21. Added text mode display.
22. Added display of range and mean.
23. Added delta time to click-and-drag.
24. Added file extension .rte.
25. Added GraphEventData to Options menu.
26. Added set defaults button.
27. Added Save Options menu.
28. Added ini file.
29. Added new event header and trailer fields.
30. Added decode of filter list.
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Please review all release notes between the software version you are 
running and the version you wish to install.

 1 Corrected drag and drop of a file to shortcut
Fixed drag and drop of a file on to the non running executable (or a 
shortcut) that generated a “Cannot focus a disabled or invisible win-
dow” popup box.

 2 Corrected print graph x axis
Fixed print graph x axis min. and max values when zoomed.

 3 Corrected scroll bars to default on file open
Forced scroll bars to default on file open.

 4 Corrected close files handle
Fixed file closing handle type on “File” “Exit” menu.

 5 Corrected event station comment
Fixed event header and trailer station comment field length.

 6 Corrected continuous trigger start time
Fixed continuous trigger start time field length.

 7 Corrected display problem
Fixed display problem with added event header and trailer fields.

 8 Corrected divide by zero with no data
Fixed divide by zero when file has only an event header and no data 
when a user clicks the “graph” tab.

 9 Removed range from status line display
Removed range from status line display.

 10 Modified opening files to be Read-Only
Change file routines from pascal type to windows handle type so that 
the data files can be opened read-only.

 11 Modified hard coded field lengths
Replaced hard coded position/length values (in event header and 
trailer decode) with entries already defined in the include file.

 12 Modified filed sizes in event header and trailer
Change size of sensor VPU field in header and trailer. Applied change 
in field sizes in event header and trailer per Recording Format Speci-
fication (May 13, 2004).
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 13 Added vertical range to Status line text
In data graph window, added vertical range to Status line text.

 14 Added drag and drop of a file to running program
Added drag and drop of a file from Windows Explorer on to the run-
ning executable. Rt_View cannot have a file open when drag and 
drop is performed.

 15 Added units label to Y scale values
Added units label (V,G) to y scale values.

 16 Added ScaleByTrace option
Added ScaleByTrace option to allow common scaling of all displayed 
channels or independent scaling of each channel.

 17 Added graph Y center line value
Added graph Y center line value.

 18 Added mean removal option
Added mean removal option.

 19 Added graph zoom/unzoom
Added graph zoom/unzoom via left/right mouse button clicks.

 20 Added print graph Y center line value
Added print graph Y center line value.

 21 Added text mode display
Added text mode display of ScaleByTrace and MeanRemoval to dis-
play and print.

 22 Added display of range and mean
Added display of range and mean to each graph for display and print.

 23 Added delta time to click-and-drag
Added delta time to click-and-drag to zoom.

 24 Added file extension .rte
Added file extension .rte to file open dialog box.

 25 Added GraphEventData to Options menu
Added GraphEventData to Options menu to allow graphing of event 
data to display when Event Header, Trailer or Data is clicked on in 
the Contents list.
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 26 Added set defaults button
Added set defaults button (1.2V/G) to Gs Entry window under 
options.

 27 Added Save Options menu
Added Save Options menu item to put Option menu setting to ini file.

 28 Added ini file
Added ini file for the application window size and state save/restore.

 29 Added new event header and trailer fields
Added time source, time quality and station comment to event 
header and trailer. Added channel gain, channel A/D resolution, 
channel FSA, channel code, sensor FSA and sensor VPU to event 
header and trailer. Added sensor units fields.

 30 Added decode of filter list
Added decoding of filter list codes.
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